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Your Best STL Learning Tools

Welcome to your Best STL training course.

As part of your training, we provide you with the following tools and resources to support and enhance your learning experience.

Thank you for choosing Best STL.
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Quick reference: Excel shortcuts

CTRL combination shortcut keys

	Key
	Description

	CTRL+SHIFT+(
	Unhides any hidden rows within the selection.

	CTRL+SHIFT+)
	Unhides any hidden columns within the selection.

	CTRL+SHIFT+&
	Applies the outline border to the selected cells.

	CTRL+SHIFT_
	Removes the outline border from the selected cells.

	CTRL+SHIFT+~
	Applies the General number format.

	CTRL+SHIFT+$
	Applies the Currency format with two decimal places (negative numbers in parentheses).

	CTRL+SHIFT+%
	Applies the Percentage format with no decimal places.

	CTRL+SHIFT+^
	Applies the Exponential number format with two decimal places.

	CTRL+SHIFT+#
	Applies the Date format with the day, month, and year.

	CTRL+SHIFT+@
	Applies the Time format with the hour and minute, and AM or PM.

	CTRL+SHIFT+!
	Applies the Number format with two decimal places, thousands separator, and minus sign (-) for negative values.

	CTRL+SHIFT+*
	Selects the current region around the active cell (the data area enclosed by blank rows and blank columns).

In a PivotTable, it selects the entire PivotTable report.

	CTRL+SHIFT+:
	Enters the current time.

	CTRL+SHIFT+"
	Copies the value from the cell above the active cell into the cell or the Formula Bar.

	CTRL+SHIFT+Plus (+)
	Displays the Insert dialogue box to insert blank cells.

	CTRL+Minus (-)
	Displays the Delete dialogue box to delete the selected cells.

	CTRL+;
	Enters the current date.

	CTRL+`
	Alternates between displaying cell values and displaying formulas in the worksheet.

	CTRL+'
	Copies a formula from the cell above the active cell into the cell or the Formula Bar.

	CTRL+1
	Displays the Format Cells dialogue box.

	CTRL+2
	Applies or removes bold formatting.

	CTRL+3
	Applies or removes italic formatting.

	CTRL+4
	Applies or removes underlining.

	CTRL+5
	Applies or removes strikethrough.

	CTRL+6
	Alternates between hiding objects, displaying objects, and displaying placeholders for objects.

	
	

	CTRL+8
	Displays or hides the outline symbols.

	CTRL+9
	Hides the selected rows.

	CTRL+0
	Hides the selected columns.

	CTRL+A
	Selects the entire worksheet. 

If the worksheet contains data, CTRL+A selects the current region. Pressing CTRL+A a second time selects the current region and its summary rows. Pressing CTRL+A a third time selects the entire worksheet.

When the insertion point is to the right of a function name in a formula, displays the Function Arguments dialogue box.

CTRL+SHIFT+A inserts the argument names and parentheses when the insertion point is to the right of a function name in a formula.

	CTRL+B
	Applies or removes bold formatting.

	CTRL+C
	Copies the selected cells. 

CTRL+C followed by another CTRL+C displays the Clipboard.

	CTRL+D
	Uses the Fill Down command to copy the contents and format of the topmost cell of a selected range into the cells below.

	CTRL+F
	Displays the Find and Replace dialogue box, with the Find tab selected. 

SHIFT+F5 also displays this tab, while SHIFT+F4 repeats the last Find action.

CTRL+SHIFT+F opens the Format Cells dialogue box with the Font tab selected.

	CTRL+G 
	Displays the Go To dialogue box. 

F5 also displays this dialogue box.

	CTRL+H 
	Displays the Find and Replace dialogue box, with the Replace tab selected.

	CTRL+I
	Applies or removes italic formatting.

	CTRL+K
	Displays the Insert Hyperlink dialogue box for new hyperlinks or the Edit Hyperlink dialogue box for selected existing hyperlinks.

	CTRL+N 
	Creates a new, blank workbook.

	CTRL+O 
	Displays the Open dialogue box to open or find a file.

CTRL+SHIFT+O selects all cells that contain comments.

	CTRL+P
	Displays the Print dialogue box.

CTRL+SHIFT+P opens the Format Cells dialogue box with the Font tab selected.

	CTRL+R
	Uses the Fill Right command to copy the contents and format of the leftmost cell of a selected range into the cells to the right.

	CTRL+S
	Saves the active file with its current file name, location, and file format.

	CTRL+T
	Displays the Create Table dialogue box.

	CTRL+U
	Applies or removes underlining.

CTRL+SHIFT+U switches between expanding and collapsing of the formula bar. 

	CTRL+V 
	Inserts the contents of the Clipboard at the insertion point and replaces any selection. Available only after you have cut or copied an object, text, or cell contents.

CTRL+ALT+V displays the Paste Special dialogue box. Available only after you have cut or copied an object, text, or cell contents on a worksheet or in another program.

	CTRL+W
	Closes the selected workbook window.

	CTRL+X 
	Cuts the selected cells.

	CTRL+Y
	Repeats the last command or action, if possible.

	CTRL+Z
	Uses the Undo command to reverse the last command or to delete the last entry that you typed.

CTRL+SHIFT+Z uses the Undo or Redo command to reverse or restore the last automatic correction when AutoCorrect Smart Tags are displayed.


Function keys

	Key
	Description

	F1
	Displays the Microsoft Office Excel Help task pane.

CTRL+F1 displays or hides the Ribbon, a component of the Microsoft Office Fluent user interface.

ALT+F1 creates a chart of the data in the current range.

ALT+SHIFT+F1 inserts a new worksheet.

	F2
	Edits the active cell and positions the insertion point at the end of the cell contents. It also moves the insertion point into the Formula Bar when editing in a cell is turned off.

SHIFT+F2 adds or edits a cell comment.

CTRL+F2 displays the Print Preview window.

	F3
	Displays the Paste Name dialogue box.

SHIFT+F3 displays the Insert Function dialogue box.

	F4
	Repeats the last command or action, if possible.

CTRL+F4 closes the selected workbook window.

	F5
	Displays the Go To dialogue box.

CTRL+F5 restores the window size of the selected workbook window.

	F6
	Switches between the worksheet, Ribbon, task pane, and Zoom controls. In a worksheet that has been split (View menu, Manage This Window, Freeze Panes, Split Window command), F6 includes the split panes when switching between panes and the Ribbon area. 

SHIFT+F6 switches between the worksheet, Zoom controls, task pane, and Ribbon.

CTRL+F6 switches to the next workbook window when more than one workbook window is open.

	F7
	Displays the Spelling dialogue box to check spelling in the active worksheet or selected range.

CTRL+F7 performs the Move command on the workbook window when it is not maximized. Use the arrow keys to move the window, and when finished press ENTER, or ESC to cancel.

	F8
	Turns extend mode on or off. In extend mode, Extended Selection appears in the status line, and the arrow keys extend the selection.

SHIFT+F8 enables you to add a nonadjacent cell or range to a selection of cells by using the arrow keys.

CTRL+F8 performs the Size command (on the Control menu for the workbook window) when a workbook is not maximized.

ALT+F8 displays the Macro dialogue box to create, run, edit, or delete a macro.

	F9
	Calculates all worksheets in all open workbooks.

SHIFT+F9 calculates the active worksheet.

CTRL+ALT+F9 calculates all worksheets in all open workbooks, regardless of whether they have changed since the last calculation.

CTRL+ALT+SHIFT+F9 rechecks dependent formulas, and then calculates all cells in all open workbooks, including cells not marked as needing to be calculated.

CTRL+F9 minimizes a workbook window to an icon.

	F10
	Turns key tips on or off.

SHIFT+F10 displays the shortcut menu for a selected item.

ALT+SHIFT+F10 displays the menu or message for a smart tag. If more than one smart tag is present, it switches to the next smart tag and displays its menu or message.

CTRL+F10 maximizes or restores the selected workbook window.

	F11
	Creates a chart of the data in the current range.

SHIFT+F11 inserts a new worksheet.

ALT+F11 opens the Microsoft Visual Basic Editor, in which you can create a macro by using Visual Basic for Applications (VBA).

	F12
	Displays the Save As dialogue box.


Other useful shortcut keys

	Key
	Description

	ARROW KEYS
	Move one cell up, down, left, or right in a worksheet. 

CTRL+ARROW KEY moves to the edge of the current data region (data region: A range of cells that contains data and that is bounded by empty cells or datasheet borders.) in a worksheet.

SHIFT+ARROW KEY extends the selection of cells by one cell.

CTRL+SHIFT+ARROW KEY extends the selection of cells to the last nonblank cell in the same column or row as the active cell, or if the next cell is blank, extends the selection to the next nonblank cell.

LEFT ARROW or RIGHT ARROW selects the tab to the left or right when the Ribbon is selected. When a submenu is open or selected, these arrow keys switch between the main menu and the submenu. When a Ribbon tab is selected, these keys navigate the tab buttons.

DOWN ARROW or UP ARROW selects the next or previous command when a menu or submenu is open. When a Ribbon tab is selected, these keys navigate up or down the tab group.

In a dialogue box, arrow keys move between options in an open drop-down list, or between options in a group of options.

DOWN ARROW or ALT+DOWN ARROW opens a selected drop-down list.

	BACKSPACE
	Deletes one character to the left in the Formula Bar.

Also clears the content of the active cell.

In cell editing mode, it deletes the character to the left of the insertion point.

	DELETE
	Removes the cell contents (data and formulas) from selected cells without affecting cell formats or comments. 

In cell editing mode, it deletes the character to the right of the insertion point. 

	END
	Moves to the cell in the lower-right corner of the window when SCROLL LOCK is turned on.

Also selects the last command on the menu when a menu or submenu is visible.

CTRL+END moves to the last cell on a worksheet, in the lowest used row of the rightmost used column. If the cursor is in the formula bar, CTRL+END moves the cursor to the end of the text. 

CTRL+SHIFT+END extends the selection of cells to the last used cell on the worksheet (lower-right corner). If the cursor is in the formula bar, CTRL+SHIFT+END selects all text in the formula bar from the cursor position to the end—this does not affect the height of the formula bar. 

	ENTER
	Completes a cell entry from the cell or the Formula Bar, and selects the cell below (by default).

In a data form, it moves to the first field in the next record.

Opens a selected menu (press F10 to activate the menu bar) or performs the action for a selected command.

In a dialogue box, it performs the action for the default command button in the dialogue box (the button with the bold outline, often the OK button).

ALT+ENTER starts a new line in the same cell.

CTRL+ENTER fills the selected cell range with the current entry.

SHIFT+ENTER completes a cell entry and selects the cell above.

	ESC
	Cancels an entry in the cell or Formula Bar. 

Closes an open menu or submenu, dialogue box, or message window.

It also closes full screen mode when this mode has been applied, and returns to normal screen mode to display the Ribbon and status bar again.

	HOME
	Moves to the beginning of a row in a worksheet.

Moves to the cell in the upper-left corner of the window when SCROLL LOCK is turned on.

Selects the first command on the menu when a menu or submenu is visible.

CTRL+HOME moves to the beginning of a worksheet.

CTRL+SHIFT+HOME extends the selection of cells to the beginning of the worksheet.

	PAGE DOWN
	Moves one screen down in a worksheet. 

ALT+PAGE DOWN moves one screen to the right in a worksheet.

CTRL+PAGE DOWN moves to the next sheet in a workbook.

CTRL+SHIFT+PAGE DOWN selects the current and next sheet in a workbook.

	PAGE UP
	Moves one screen up in a worksheet.

ALT+PAGE UP moves one screen to the left in a worksheet.

CTRL+PAGE UP moves to the previous sheet in a workbook.

CTRL+SHIFT+PAGE UP selects the current and previous sheet in a workbook.

	SPACEBAR
	In a dialogue box, performs the action for the selected button, or selects or clears a check box.

CTRL+SPACEBAR selects an entire column in a worksheet.

SHIFT+SPACEBAR selects an entire row in a worksheet.

CTRL+SHIFT+SPACEBAR selects the entire worksheet. 

· If the worksheet contains data, CTRL+SHIFT+SPACEBAR selects the current region. Pressing CTRL+SHIFT+SPACEBAR a second time selects the current region and its summary rows. Pressing CTRL+SHIFT+SPACEBAR a third time selects the entire worksheet. 

· When an object is selected, CTRL+SHIFT+SPACEBAR selects all objects on a worksheet.

ALT+SPACEBAR displays the Control menu for the Microsoft Office Excel window.

	TAB
	Moves one cell to the right in a worksheet.

Moves between unlocked cells in a protected worksheet.

Moves to the next option or option group in a dialogue box.

SHIFT+TAB moves to the previous cell in a worksheet or the previous option in a dialogue box.

CTRL+TAB switches to the next tab in dialogue box.

CTRL+SHIFT+TAB switches to the previous tab in a dialogue box.


Unit 1: What is a dashboard?
Dashboards are a type of report. They help turn often large amounts of data into a digestible page that enables easy analysis. This form of data analysis can be part of Business Intelligence (BI).
Why use a dashboard?

Many companies have access to large amounts of data, perhaps in a data warehouse or spread across multiple file servers. Decision makers often want to cut through this data and look for patterns. Dashboards are an excellent way to turn large amounts of data into usable and actionable reports.
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A dashboard is a visual interface that provides at-a-glance views into key measures relevant to a particular objective or business process. A dashboard consists of three key attributes:
1. Displays data graphically (such as in charts). Provides visualizations that help focus attention on key trends, comparisons, and exceptions.

2. Displays only data that is relevant to the goal of the dashboard.

3. Contains predefined conclusions relevant to the goal of the dashboard and relieves the reader from performing their own analysis.
Dashboard examples
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Common features of a dashboard
Dashboards will often have the following features:

A single page. One page of information gives a high-level analysis. This one page view forces the most prominent trends to the front.

Highly visual. To enable quick takeaways, the data is represented in a very visual way.

Interactivity. Simple controls on the dashboard allow the user of the report to modify the view, perhaps choosing different parameters.

Timely. Dashboards will be most effective by having a method to be as up to date as possible. 

Multi-format. To offer different views on the same data, different formats of data representation will be used, combining charts, tables, images and other visualisations.
Relevant. Only data appropriate to the dashboard is going to be displayed.

Why use Excel to create dashboards?

There are a wealth of BI tools available to help create dashboards. However the variety of tools available, the ubiquity of Excel on people’s computers, combined with the ability to export these interfaces to the Web make it a straightforward tool to use. A formalized BI platform could be overkill and too expensive for a company’s needs. Excel is familiar and most companies have already budgeted for installing Microsoft Office.
Preparing to build a dashboard

Before you start

Before you create a dashboard, you should take time to research and define the following points:

Define the message – what is the purpose?

Establish the audience – what level of user is going to consume the report?

Define the measurements – which metrics will support the message?

List the data sources – build an inventory of data feeds you will need to create the measurements.

Separating data from presentation
Many people rush in creating charts and directly working with the data. This will work in the short term but you will find as you move forward it becomes harder and harder to maintain. Strive to separate the data sheet from the presentation sheet. Better still, have at least three sheets:

Data –source data, cleaned but not extensively formatted. Often driven by a refreshable data feed. Data is often repetitive, with recurring items. Sometimes referred to as a ‘flat file’
Analysis – interstitial ‘helper’ tables that coerce the source data into a usable format. Often aggregating, totalling etc. This could be in the form of a PivotTable, or a cross-tabular table you have compiled with formulas and functions.
Presentation – the formatted report that users will consume. Could be charts, simple tables, images, one line of commentary etc.
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1 - Data sheet. Messy to look at, awkward for humans to comprehend, but an excellent starting point for analysis
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2 - Analysis. Aggregations and calculations based on the source data
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3 - Presentation. Take the Analysis data and present in a digestable and actionable format

This is the best practice by far. Let the data be the data – often ugly – but leaving the presentation sheet clean and free of extra details. The analysis layer will help you bridge the gap between the two – very useful for features such as PivotTables.
How to use this manual

Everyone will have a different use case, a different audience and a different set of reporting metrics required for their industry. In this manual you will walk through a number of Excel features commonly used in dashboard reporting. You can mix and match these features in any combination to create your own reports. In the appendix you will find three projects to give you some ideas of how you could develop a company dashboard. You should select the most suitable components for your report.
Different Excel versions

This manual focuses on the 2010 and 2013 versions of Excel. Most of the following is also possible in 2007 apart from a few PivotTable features such as Slicers and Timelines.
Unit 2: PivotTables and PivotCharts 

 In this unit, you will learn how to: 
· Create a PivotTable from a list of data 

· Modify a PivotTable to change data display
· Create a PivotChart  

· Use external data to create a PivotTable 

A major function of any spreadsheet program is to help you derive meaning from your data. An Excel PivotTable is a great tool for getting perspective on and analysing relationships between the columns and rows of your worksheet. 
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What is a PivotTable? 

A PivotTable is a powerful tool for exploring and analysing information. A PivotTable helps you organise and manipulate the raw data in your spreadsheet, giving you insight into patterns or relationships that might not be obvious at first glance. 

You can base a PivotTable on data in your current workbook or even external data from another source if you wish. With a PivotTable, you can conveniently drag and drop columns of your data to different areas of the table to examine relationships or trends that may not be obvious in a traditional Excel table or database.  

Preparing Data to Create a PivotTable 
Ideally, source data for a PivotTable should be structured like a traditional Excel table or database. The source data should have a row of unique column headings distinguishing the data and there should be no empty columns interspersed within the data. Also, blank rows in a source list or database can limit the usefulness of your PivotTable. 

The following image shows a block of contiguous data that is well suited for a PivotTable. 
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 Notice that there are no empty rows or columns and that every column of data has a unique label. 

Creating a PivotTable 

To create an Excel 2010 PivotTable: 

1. Select the range of data that you want to base the table on 

2. On the Insert Ribbon, Tables group, click the PivotTable button 

3. When the Create PivotTable dialogue box appears, choose the table or range option, so the PivotTable will be based on the Excel table or range you selected.  

4. Once you select your data source, you can then choose to locate your PivotTable in an Existing Worksheet or a New Worksheet.  

5. Click OK to create your PivotTable.  

For information on how to create a PivotTable from external data, please see the downloadable reference material. 

Adding Fields to the PivotTable 

Once your PivotTable appears, you can add information to it by placing checks in the boxes next to the headings in the PivotTable field list or by dragging the fields to the designated areas. 
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Creating a PivotTable Frame (Classic PivotTable Layout) 

You can also create a PivotTable by creating an empty table frame (also known as a classic layout) and adding and arranging data in the table by dropping and dragging column headings onto the frame. 

To create a PivotTable frame: 

1. Click the PivotTable button on the Insert Ribbon to display the PivotTable dialogue box. 

2. Follow the same process as described before for creating an Excel 2010 PivotTable.  

3. Before adding data to the PivotTable table, right click on it and choose Table Options from the pop up menu 

4. In the Options box, choose the Display tab and then put a checkmark in the Classic PivotTable Layout box.  

PivotTable areas 

To make the best use of your PivotTable, you should understand what the various areas in a PivotTable are for. 

A PivotTable is broken into four main areas: Report (also known as Filter), Data, Row, and Column. 

The Report (or Filter) Field area is ideally suited to column headings (fields) that are used to identify periodic or organisational groupings of the data in your other columns, e.g. month or year column headings. 

The Values area provides the underlying context for the rest of the PivotTable. The column heading you choose for the data area of the table normally has numeric values associated with it. 

The Row and Column fields are used to categorise the data you want to examine. When you choose column headings to be placed in the row and column fields, you can see how your choices relate to each other in the context of the Data being examined. 

Rearranging PivotTable Data 

Once a PivotTable has been created, it is easy to rearrange the data if necessary. 

Here we have a table showing profit by product type across regions. 
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If we wanted to show sales figures instead of profit figures, you can remove the profit information from the data area by dragging the Sum of Profit heading from the PivotTable Field List out of the table area to drop it anywhere outside the PivotTable.
You can rearrange any of the categories of data in your table by following this process of dragging headings out of the table and then replacing them with headings from the PivotTable field list.  

Hiding and Showing Field Data 

You will also notice that the row, column, and page areas of the PivotTable field list have dropdown lists associated with them, indicated by small downward pointing triangles.  
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You can use these drop-down lists to rearrange your data according to specific elements in a given category.  

The PivotTable Tools Ribbon 

If you close the PivotTable Field List, you can always get it back by clicking the Field List button on the Options Ribbon.  


[image: image16]
The Options Ribbon and the Design Ribbon will become available whenever you click inside the borders of your PivotTable. 

Modifying Calculations and Data Area Display 

The default setting for PivotTable calculations is SUM. This means that the totals shown in the Grand Total areas of the PivotTable will be derived from summing (adding) the values in the rows and columns. 

To modify the way these totals are calculated: 

1. Right click on the Sum of ‘X’ field in the upper left corner of the PivotTable.  

2. Select Value Field Settings from the shortcut menu, then Summarize value field by tab. 

3. Switch the type of calculation to Count, Average, Max or Min, Product, Standard deviation, or Variance.  

4. Click OK. 

Formatting a PivotTable 

To format a PivotTable: 

1. Click on a cell in the PivotTable, and from the PivotTable Tools tab select the Design Ribbon. 

2. On the Design Ribbon, click on one of the preset styles in the PivotTable Styles group to quickly apply preset formatting to the table 

Refreshing a PivotTable 

The data in a PivotTable is not linked directly to the source table or range. Instead, the PivotTable is based on a hidden copy of the source data that is kept in memory by Excel. This means that changes to the original source list or database will not be automatically updated in the PivotTable. If you make changes in the source data, you must refresh the PivotTable to update it. 

To refresh a PivotTable: 

1. Click the Refresh button on the Data Ribbon or on the Options Ribbon; or 

2. Right click on a cell in the data area of the table and then click the Refresh Data option from the pop up menu. 

Grouping

Grouping is a powerful feature of PivotTables that allow you to create useful groupings of data. You can group text data, numerical data or date data.
Often this is akin to creating a new field in the source data but often much easier. Creating groups usually creates a brand new field on the PivotTable that you can treat like other PivotTable fields.

The process is the same although the results will be different; the field to be grouped must be in the Row or Column section.

Grouping text fields

Grouping text fields give you the ability to create manual categories in the data.  You could organise people into teams, or products into sections.
1. Highlight all the items you wish to group

2. Right-click and press Group

You can rename the group by clicking on the grouped cell and overtyping.
Grouping numerical fields

Grouped numerical fields give you bands to spot patterns much easier. You could analyse sales by quantity sold, or invoices by the amount of days overdue.
1. Right-click an item in the field and press Group

2. Select the start and end value, as well as the interval and press OK.

Grouping date fields

Grouping dates is one of the most useful features of PivotTables. By grouping dates you can coerce the data into monthly or yearly grouping, bypassing the need to create these columns in the source data which can be time-consuming.
1. Right-click a date and press Group

2. Select the start and end date, then click to select to group by Months, Years etc. and press OK.
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Ungrouping

Right-click a grouped item and press Ungroup to remove the grouping.

Using Slicers to Manipulate PivotTables 

Slicers 

Slicers are visual controls that let you quickly filter data in a PivotTable in an interactive, intuitive way. If you insert a slicer, you can use buttons to quickly segment and filter the data to display just what you need. In addition, when you apply more than one filter to your PivotTable, you no longer have to open a list to see which filters are applied to the data. Instead, it is shown there on the screen in the slicer. You can make slicers match your workbook formatting and easily reuse them in other PivotTables, PivotCharts, and cube functions. 

Insert the Slicer 

1. Click anywhere in the PivotTable data area 

2. From the Options ribbon located in the PivotTable Tools contextual tab click the 

3. Insert Slicer button located on the Sort & Filter group 

For each field chosen, a separate filter box is displayed containing the data which can then be selected for viewing 
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Click on the items you wish to view using the CTRL key if the items are not contiguous 

The result would look as follows 
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Using Slicers with multiple PivotTables

You can manipulate multiple PivotTables at once with Slicers. This can be a powerful BI tool.

Create a Slicer as above and then go to the Slicer Menu, then PivotTable Connections. This window will list all the available PivotTables that you can connect the Slicer to. Check the boxes as required and press OK. That Slicer can now filter all the connected PivotTables.
Using Timelines to filter on dates (Excel 2013 only)

Excel 2013 has a tool called Timelines. By default the data is split into months, though manipulation allows you to break this down into weeks, quarters, years or even days if you prefer.
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If you already make user of Slicers in your PivotTables and PivotCharts, you will be very comfortable with the timeline feature.
To add a Timeline:

1. Click in your PivotTable data area and from the Analyse ribbon select Insert Timeline from the Filter group.

2. Select the date field required and your Timeline is now ready to be used to filter your date field chosen.

You can change the specified dates by simply dragging each end of the timeline.

Creating a PivotChart 

To create a chart based on an existing PivotTable: 

1. Click a cell in the table 

2. On the Options ribbon, Tools group, click the PivotChart button then select a chart type then click OK. You can select any chart type except XY Scatter, Bubble, or Stock charts. 

Or 

1. On the Insert ribbon, Charts group, click on a chart type then click OK.  

2. Once the chart has been created, select the chart area and then the Design ribbon which will allow you to apply a preset format to your chart via the Chart Styles buttons. 

Note: Any changes or rearranging of field values in the PivotTable will automatically be reflected in the PivotChart and vice versa. 

For information on how to create a PivotChart from scratch, please see the downloadable reference material. 

PivotTables, PivotCharts and Slicers in Dashboards

Within dashboards PivotTables and PivotCharts are a key ingredient. Their ability to summarise and aggregate large blocks of data makes them essential. Use PivotTables to rearrange data into a coherent message. They could be part of the Analysis sheet, or part of the Presentation itself.
Using a Slicer will help give filtering to the PivotTable. You won’t have to create any additional functionality to make the dashboard interactive. The Slicer’s ability to work with multiple tables simultaneously is also perfect for dashboards.
Frequent PivotTable Questions and Answers
I keep getting the error “The PivotTable field name is not valid”

If you don’t have one of your headings in place and you force the selection of data you’ll get a horrible error message: You need to go back and ensure every field has a heading.

When I refreshed my PivotTable, my data disappeared

You can force this by creating a PivotTable on the same sheet, populate it, and then change Sales to Sells and refresh the table. Solve this simply by dragging the new field onto the pivot

My PivotTable always uses COUNT instead of Sum

Note that even one blank cell convinces the PivotTable it is dealing with text data, so it will automatically use the COUNT analysis. Switch to SUM and it will work, it’s just more of an annoyance than anything else. Best practice, keep the data robust.

My PivotTable constantly adjusts the columns in my workbook to Autofit the headings 

You can force this by altering columns widths on your PivotTable, then refreshing. If you right click on the PivotTable and choose PivotTable Options, on the Layout & Format tab untick Autofit Column Widths On Update.

The Defer Layout option locked me out of other functionality such as sorting, filtering, group.

You use the Defer Layout option when you are creating a PivotTable from a massive data source, changing the layout can be sluggish. Therefore tick “Defer Layout Update” at the bottom of the Field List pane and only update when your choices have been made. Note you will be frozen out of sorting etc. If the data source continues to grow consider using the PowerPivot Addin.

Older versions of Excel do not open my PivotTable properly

Save your spreadsheet in the 97-2003 file format. Advanced features used in later versions will be stripped out if opened in earlier versions of Excel.

When I try to group a field I get an error message

You cannot group text field, or date fields with text or blanks, or date fields formatted as text, or fields in the report filter area.

My PivotTable shows the same data item twice

Check you haven’t got a space at the end of the value.

Deleted data items still show up in the filter area

You can force this by filtering your PivotTable on the worksheet, then deleting out all the, say, EAST records. East will still show up in the Region filter and is still accessible as a filter option, plus the data is still in the cache so you can still drill down into it. Remedy this either by rebuilding and refresh or right-clicking and choosing PivotTable Options and on the data tab, setting the number of items to retain per field to None.

I refreshed my PivotTable and now my calculated fields are displayed as error values

Check that a field used in the calculation has not been renamed or deleted. If it has, you will need to edit the Calculated Field accordingly

How do I make my PivotTable refresh automatically?

In PivotTable Options, select the Data tab, and tick Refresh data when opening the file.  

How do I refresh all PivotTables in a workbook at the same time?

As above for all, or write code. Note you still need to Refresh when your source data changes. 

How can I sort data items in a unique order that is not ascending or descending?

You can rearrange data items in your PivotTable manually by simply typing the exact name of the data item where you would like to see its data. You can also drag the data item where you want it. You can also rearrange lists according to built in Custom Lists. 

How do I turn my PivotTable into hard data?

Simply achieved by using Copy Paste/PasteSpecial - Values

Why does my pivot chart exclude months for certain data items?

This is simply because there is no data for those months. To view them anyway, right click on the date field and in Field Settings choose Show Items with no data.

How do I add a rank number (i.e. 1-10 Sales figures) to my PivotTable?

Use the RANK function:
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How do I hide calculation errors in my PivotTable?

In PivotTable Options on the Layout & Format tab, tick For Error Values Show, then enter a replacement value

How can I reduce the size of my PivotTable reports?

Creating a PivotTable almost doubles the size of a workbook. Simply copy this PivotTable sheet to a new workbook. If you then need the source data, double click on individual cells or on the Grand Total to rebuild data

How can I easily create a separate PivotTable for each market?

Drop the Market field into the Report Filter and choose Show Report Filter Pages from the PivotTable Options drop down. 

How do I move the PivotTable?

On the Options Tab choose Move PivotTable.

Unit 2 Practice Activity 

1. Open Exercise 2.0 PivotTables.xlsx.

2. Create a PivotTable and keep re-arranging it to show the following things:

a. Total salaries in this data (£1,390,909)

b. Total salaries for yellow cars in the London county (£36,558)

c. How many blue Vectras in the fleet (3)

d. Average salaries for 1 year's service (£35,428)

e. How many cars were issued in 2010 (6)

f. How many yellow cars were issued in 2011 for the Kent area (2) 
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Unit 3: Useful Functions 

 In this unit, you will learn how to use the following functions: 
· IF

· SUMIFS 

· EDATE 

· INDEX 

· MATCH 

· OFFSET

· CHOOSE 

Functions and Dashboards

Use of various functions can help extract your data into usable tables that can then be presented on the dashboard. Often they can work on the source data without disturbing it with ease.

Using Nested IF statements
A single IF statement is used for displaying two possible values depending on a condition or logical test. 

=IF(logical_test,True,False)

For example, suppose you want to display either Pass or Fail for scores above (or equal) to 70 and Fail for scores below 70.
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The formula to use would be a single IF statement:

=IF(B2>=70,”Pass”,”Fail”)

But if instead you want to award grades Excellent, Very Good, Fair or Poor then you will need to use more than one nested IF statement. In this case you would use 3 IFs.
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To create this nested IF statement:

1. Start by clicking in cell C2

2. Select the Formulas tab, Logical, IF

3. Starting with the higher scores, enter the logical tewst B2>=90

4. Enter “Excellent” as the value if true

5. Click in the value_If_false box

6. Select IF from the function list to the left of the formula bar.. 
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7. A blank function argument window now appears ready for you to enter the second logical test:
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8. Type Very Good as the value_if_true

9. Select the value-if-false box and as before and select IF from the function list. 
10. The final multiple IF statement reads

=IF(B2>=90,"Excellent",IF(B2>=70,"Very Good",IF(B2>=50,"Fair","Poor")))
Use COUNTIFS and SUMIFS

Excel has the useful functions COUNTIF and SUMIF which are able to count the number of records or sum values of a field based on a criteria.  In the list below for example theses function calculate there are 10 ‘Full Time’ employees with a total salary of £604,760.  Here are the formulas:

=COUNTIF(B3:B25,"Full Time")
=SUMIF(B3:B25,"Full Time",D3:D25)
Similarly the AVERAGEIF function would calculate the average salary for the Full Time employees:

=AVERAGEIF(B3:B25,"Full Time",D3:D25) 

Since Excel 2007 there has been a corresponding set of functions ending with the letter S. COUNTIFS, SUMIFS and AVERAGEIFS. These functions allow for multiple criteria. For example, the number of Full Time employees with a job rating of 5.
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COUNTIFS

The COUNTIFS function counts the number of cells where the multiple criteria are true in multiple ranges.

COUNTIFS(criteria_range1, criteria 1, criteria_range2, criteria2)

In the example the first criteria range and first criteria is Status range B3:B25 and “Full Time”. The second criteria range and second criteria is Job rating range C3:C25 and Job Rating 5) Here is the function:

=COUNTIFS(B3:B25,"full time",C3:C25,5)
SUMIFS
=SUMIFS(Sum range, criteria_range1, criteria 1, criteria_range2, criteria2)

The SUMIF function calculates the total salary for the same two criteria.

=SUMIFS(D3:D25,B3:B25,"full time",C3:C25,5)
In this example there are 3 Full Time employees with a total salary of £151,210. 

Excel allows a maximum of 127 range/criteria pairs.

Creating Tabulated data using SUMIFS

Rather than just calculating one result from a SUMIFS it is possible to create tabulated data that allows a comparison to be made between all the Job Ratings and Status types. 
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To create tabulated data using the SUMIFS function first type all the different values as Row and column labels. Then click at the intersection point K3.and create the SUMIFS function:
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Note about Partial Absolute Referencing

All the criteria ranges have Absolute references.
The Status criteria is partially Absolute where the row is fixed (K$2).
The Job rating criteria is partially Absolute where the column is fixed ($J3).

The full formula is:

=SUMIFS($D$3:$D$25,$B$3:$B$25,K$2,$C$3:$C$25,$J3)
It can be Autofilled or copied down and across to fill the table as follows.
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Creating Tabulated data with a PivotTable
The same tabulated data created using Sumifs functions can be created with a PivotTable.
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Row Labels as the Job Rating
Column labels as Status
Value as Salary (with Currency Number format)

Whereas the PivotTable needs to be refreshed if there is a change in the data, the Sumifs table will update automatically.

Using the EDATE function

The EDATE function will count on a number of months from a specified date.

=EDATE(start_date, months)
You can specify positive or negative numbers to go forward or backward from the start date respectively. Because each month has different days, adding and subtracting days to a date can get complex. Some calculations are easier to do with months rather than the usual Excel unit of a day, especially when leap years are involved. EDATE gives a way to get around this.
=EDATE(A1, 6)

This will give the date 6 months from the date in A1.

=EDATE(A1, -12)

This will give the date 1 year before the date in A1.

Use the INDEX function for retrieving information by location

The INDEX function returns a value or the reference to a value from within a table or range. There are two forms of the INDEX function: the array form and the reference form.  
Definition of Array: Used to build single formulas that produce multiple results or that operate on a group of arguments that are arranged in rows and columns. An array range shares a common formula; an array constant is a group of constants used as an argument.

The INDEX Array form
The INDEX array form returns the value of an element in a table or an array, selected by the row and column number indexes.

Use the array form if the first argument to INDEX is an array constant.

The Syntax for the INDEX function is as follows: -

=INDEX(array, row_num, [column_num])

The INDEX function syntax has the following arguments: -
Array (Required) is a range of cells or an array constant.

If array contains only one row or column, the corresponding row_num or column_num argument is optional.

If array has more than one row and more than one column, and only row_num or column_num is used, INDEX returns an array of the entire row or column in array.

Row_num Required. Selects the row in array from which to return a value. If row_num is omitted, column_num is required.

Column_num Optional. Selects the column in array from which to return a value. If column_num is omitted, row_num is required.

The next example shows how a value is retrieved from a table array using the INDEX function incorporating the row number and column number options.
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Using the MATCH function to locate data position
The MATCH function searches for a specified item in a range of cells, and then returns the relative position of that item in the range. For example, if the range A1:A3 contains the values 5, 25, and 38, then the formula

=MATCH(25,A1:A3,0)
returns the number 2, because 25 is the second item in the range.

Use MATCH instead of one of the LOOKUP functions when you need the position of an item in a range instead of the item itself. For example, you might use the MATCH function to provide a value for the row_num argument of the INDEX function.

=MATCH(lookup_value, lookup_array, [match_type])
Match Types

	Match_type 1 or omitted
	MATCH finds the largest value that is less than or equal to lookup_value. The values in the lookup_array argument must be placed in ascending order, for example: ...-2, -1, 0, 1, 2, ..., A-Z, FALSE, TRUE.

	Match_type 0
	MATCH finds the first value that is exactly equal to lookup_value. The values in the lookup_array argument can be in any order.

	Match_type -1
	MATCH finds the smallest value that is greater than or equal to lookup_value. The values in the lookup_array argument must be placed in descending order, for example: TRUE, FALSE, Z-A, ...2, 1, 0, -1, -2, ..., and so on.


If match_type is 0 and lookup_value is a text string, you can use the wildcard characters — the question mark (?) and asterisk (*) — in the lookup_value argument.

A question mark matches any single character; an asterisk matches any sequence of characters. If you want to find an actual question mark or asterisk, type a tilde (~) before the character.
The following example shows how the MATCH function finds the row number in which a particular item is located.
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Using the OFFSET function

Returns a reference to a range that is a specified number of rows and columns from a cell or range of cells. The reference that is returned can be a single cell or a range of cells. You can specify the number of rows and the number of columns to be returned.
=OFFSET(reference, rows, cols, [height], [width])
It can be used to retrieve data from data that is in otherwise awkward layouts. Along with VLOOKUP, INDEX and MATCH it can be a very powerful function.
=OFFSET(D3, 1, -2)
Starting from cell D3 OFFSET will retrieve the data 1 row below and 2 columns to the left (cell B4).
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=OFFSET(B2, 3, 0, 3, 2)

Starting from cell B2 OFFSET will retrieve the data 3 rows below and 0 columns to the left (cell B5). The selection will be 3 rows deep and 2 columns wide.
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Using the CHOOSE function

The Choose function displays an item from a list based on a number.  It can be used as an alternative to a multiple IF statement. 

=CHOOSE(Index_Value, item1, item2, item3)
For example it can be used to display a day of the week from a number.

=CHOOSE(Weekday(A1), “Sun”,”Mon”,Tue”,Wed”,Thu”,”Fri”,”Sat”,”Sun”)

Where A1 contains a date.

Here is another example where the CHOOSE function is used to display the correct medal for a given position in a race.

  [image: image36.png]s - e | =CHOOSE(CS,"Gold","silver","Bronze”, """, ")

A B c D 3

Mens 10,000m Final
London Olympics 2012

BEKELE Kenenisa ETH 4
BEKELE Tariku EW o3 o Bone
FARAH Mo L GR 1 27304 Gold i
MUCHIRIBedanKaroki  KEN 5 27329 i
RUPP Galen L usA 2 7m0 silver i
TADESE Zersenay ERI 6





The Choose function displays a #VALUE error if the index value is larger than the number of items listed. To avoid the error message an IF statement can be used to check for the first 3 places:

=IF(C5<=3,CHOOSE(C5,”Gold”,”Silver”,”Bronze”),””)

Unit 3 Practice Activity
1. Open Exercise 2.0 – Useful Functions.xlsx.
2. Select the Nested IFs sheet. In cell F8 create a formula to say “No action”, “Call” or “Letter” depending on how overdue the premium is.
3. Copy the result down to row 14.
4. Select the INDEX_MATCH sheet. When creating the formulas use the named ranges already created.

5. Select cell B4 and using the MATCH function locate the row reference number for the months.

6. Select cell B5 and using the MATCH function locate the column reference number for the products.

7. Select cell B6 and using the INDEX function to locate the item cross referenced by the MATCH results in B4 & B5.

8. Select cell B9 and create a formula that combines all three of the above.

9. Check the hidden sheet to compare your results.
10. Select the COUNTIFS_SUMIFS sheet. Select cell C3 build a COUNTIFS function to create a table interrogating all the possible responses. Using mixed relative / absolute referencing for the range C4:G10 and then Autofill the formula down and across.

11. Build a similar COUNTIFS function in C17 incorporating the department in B16 also. Change the value in B16 to see the table change.

12. Select cell C28 use add two COUNTIF functions together looking for all "Agree" and "Strongly Agree" responses. Divide the answer by the total amount of responses with a COUNTA function.

13. Compare your results with the hidden sheet.
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Unit 4: Conditional Formatting 

In this unit, you will learn how to: 

· Apply and work with conditional formatting in a spreadsheet 

Conditional Formatting 
In Excel 2010 you can design a worksheet in such a way that data is formatted differently, based on the values the data assume at any given time. This is called conditional formatting.  

Applying Conditional Formatting 
To use conditional formatting: 

1. Select a range of data that you want to apply the formatting to. 

2. On the Home ribbon, Styles group, click the Conditional Formatting button. 

 
[image: image37] 

This will display a menu of conditional formatting options. From this menu, you can choose: 

	 Highlight Cells Rules 
	This will highlight cells that are greater than, less than, between or equal to values that you can specify. 

	Top/Bottom Rules   
	This option will allow you to highlight the top or bottom numbers or percent in the selected cells. 

	Data Bars  
	Will display coloured bars that are indicative of the value in the cell. This is what is used in the image above. 

	Colour Scales  
	Will use different shades of colour to represent different values, from low to high.  

	Icon Sets  
	Will use sets of similar icons that will visually indicate a cell’s value. 


3. Select the option you wish to use to apply formatting. 

Creating a Conditional Formatting Rule 
If you click the New Rule option near the bottom of the conditional formatting menu, you will display the following New Formatting Rule dialogue box. 
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In this dialogue box you can configure more precise and specific conditional formatting rules. The options in the Edit the Rule Description panel will change as you click the different items in the Select a Rule Type panel.  

Removing Conditional Formatting 
If you want to remove conditional formatting rules, simply use the Clear Rules option from the menu. This option will let you clear rules for selected cells or for an entire spreadsheet. 

Using the Manage Rules Option 
The Manage Rules option will allow you to delete, edit, or add new conditional formatting rules. 

Conditional formatting on PivotTables

PivotTables help you summarise large data collections in an Excel worksheet but it can be hard to find data that matches specific critieria just by looking at the numbers. It is much easier to change a cells fill or text colour to indicate its relative value. Formats that change the appearance of a cell’s contents by applying rules are called Conditional Formats. Excel lets you apply conditional formatting rules to PivotTable cells and have the formats change position when you pivot the PivotTable.

Creating a conditional format is a lot like creating a filter. In each case you create rules indicating which cells you want to be affected by your actions. 

There is one notable drawback applying Conditional Formatting to dynamically adjusting PivotTables, in that you cannot choose the range by dragging the mouse from $E5:$13 (for example). You will lose the range as soon as the PivotTable grows & shrinks. You must select the range by selecting [your field name] value as the range.

Select [your field name] value range you want conditionally formatted. By moving the cursor to the top edge of your field header [your field name]. Left click, when you should see the cursor change to an arrow.

You now have two options. You can either apply Conditional Formatting as usual and then edit the rule, or build the rule manually from the beginning. Here, conditional formatting is applied as usual to the data body range (the central data) then edited:
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Once the rule has been created choose Conditional Formatting – Manage Rules to edit:
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As you can see, the Conditional Formatting dialog box now has an extra section at the top. Choose the third option to attach the formatting to those selected Model and Sales Date data. The conditional formatting will now remain intact when the PivotTable is refreshed. 

Conditional Formatting with Dashboards

Conditional formatting is ideal for formatting data for presentation. Depending on your dashboard style the Icon Set and Colour Scale options can be the most useful.
One thing to be aware of is how to conditionally format cells based on other cells. You should be careful with absolute and relative references in your conditional formatting to ensure it works properly.

Look at the example below.
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1. If you want cells in column A to turn red if values in column F are below £24,000, you need to do something like this:

2. Highlight the names on Column A

3. Go to Home > Conditional Formatting > New rule

4. Select Use a formula to determine which cells to format

5. Enter the formula =F7<24000
Note that F7 should be a relative reference, i.e. no $ symbols. This ensures that the rule looks at the relative row.
6. Under Format choose a formatting style

7. Press OK
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Unit 4 Practice Activity 
1. Open the file Exercise 4.0 - Conditional Formatting.xlsx.
2. Select the range B7:C41. 

3. Apply conditional formatting to the selected range to show values in excess of or equal to £6,500 in Blue (either font or shading) and values equal to or less than £5,500 in Yellow (either font or shading). 

4. Create an IF function in cell D7 to determine whether Week 2 is higher than Week 1. Have it output “1” or “0”. Copy this function down to cell D41.
5. Assign Icon Set conditional formatting to D7:D41 with an up arrow or down arrow as appropriate.
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Unit 5: Form Field Controls
You can create forms within Excel without the need to learn VBA (Visual Basic for Applications) programming. Form Controls are created using standard Excel tools from the Developer ribbon.

Form Controls can be used to enable quick and easy data input.  You can design them to print out or use online.  Forms Controls consist of such as objects as option buttons, tick boxes, and dropdown lists.  

Controls can be used to validate data, and limit user input.  The value selected in the control is returned to the spreadsheet allowing you to then use this information to display text, values, or run calculations on them

Adding Controls

To add a control to your worksheet, simply click the relevant icon on the forms dropdown, and by clicking and dragging, draw the control on to the sheet.

Once placed on the screen, you will see that it has handles at each edge and corner, allowing you to resize it as required.

Understanding Controls and How They Work

All controls must have a “cell link”. This can be any cell on the worksheet (that would generally be hidden away) that is used to store the value returned by the control.  For example, if cell B2 is used as the cell link for a tick box, the value TRUE or FALSE would be returned to cell B2 depending on whether or not the box is ticked.

Once there is a value in B2 (in this example, either True or False), you can then use that result for a calculation, function, etc.

e.g.

=IF(B2=True,”Yes I will attend”,”No I won’t be attending”)

Alternatively, if you are using a Spinner or Scrollbar to change values from 10 to 100, and using C3 as the cell link, you could use the value returned in a calculation.

e.g.

=C3*60

=C3*10

=C3*100

All controls have their own properties, which will be covered in this guide.  All controls have the ‘Cell Link’ property, which needs to be set if the result is to be used further within the spreadsheet.

Group Box and Option Buttons

From the Insert > Form Controls , click [image: image43.png]


.

Draw a Group Box on to the spreadsheet.  Highlight the heading and rename it to “April Fixtures”.
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Simply highlight the heading and overtype.  Alternatively, just delete to have no heading and just a box.

From the Insert > Form Controls, click [image: image44.png]


.

[image: image153.jpg]


Draw the Option Button in to the Group Box.  Highlight the text and type “Tottenham Hotspurs”.

[image: image154.jpg]



Add 5 more Option Buttons, and rename them “Arsenal”, “Man Utd”, “Liverpool”, “Chelsea”, and “Aston Villa”.

Resize the Group Box if necessary (by clicking one of the borders and using the handles), to fit in the other Option Buttons.

[image: image155.jpg]



Click on the CONTROL tab.  What you can see here is the properties of the Option Button control.

Click in the CELL LINK box, then click an empty cell behind in the spreadsheet.  In the example below, cell F1 has been selected.
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Then click OK.

List Box

A list box is used for displaying a list of items.  This list is controlled by values or text within a range of cells on your spreadsheet.  Dependent on the control’s properties, the user can select one or multiple choices from the list.

Combo Box

The Combo Box is basically a dropdown list.  The input range, similarly to the List Box, is taken from a range from within the spreadsheet.

The combo box is a text box with a dropdown arrow, listing items, allowing the user to select one of these.  The index number of the item is returned to the cell link, and the value back in to the text box.

Scrollbar

The scrollbar can be used either horizontally or vertically on the spreadsheet.  It is used to increase or decrease values, and the page change option (clicking anywhere in the centre of the scrollbar instead of the arrows at each end) allows faster and larger value jumps.

Spinner

The Spinner works almost exactly the same way as the Scrollbar, except that you don’t have the Page Change property.  You simply use the up and down arrows to increase and decrease values.

Using Form Controls on Dashboards
Slicers are a great way to filter data is you’re using PivotTables. But sometimes you need different functionality. Using items like scrollbars, combo boxes and check boxes can offer you other ways to restrict data and views, giving users more functionality.

Examples:

· Use a Spinner to allow users to increment the amount of rows shown on a table

· Use check boxes to add or remove visible data from a chart

· Use combo boxes to allow users to pick different dimensions e.g. regions, departments, products, people

· Use option buttons to let users choose between displaying revenue, costs or profits

Unit 5 Practice Activity
Using the Excel Legacy Form Controls from the Developer Ribbon recreate the following with Scroll Bars, How much Gratuity and How many Diners.

1. Open Exercise 5.0 – Form Controls.xlsx.
2. Enter Formulas

3. Insert Scroll Bars:
4. Gratuity Values = e.g. 1 to 37
5. Diners Values = e.g. 1 to 12

6. Create relevant Lookups

7. Format to complete
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Unit 6: Working With Charts 
In this section you will learn how to: 
· Create a chart in Excel 

· Modify a chart 

· Enhance a chart using various chart formatting features 

Creating a Chart 
Excel 2010 provides a series of chart buttons and controls on the Insert Ribbon. 
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Before you create a chart, first consider the type of chart that you require. Pie charts and bar charts are good for showing comparisons. Line graphs can be useful for showing trends and plotting relationships between variables. If you want a really visually interesting chart, consider a three dimensional type.  

 To create a chart: 

1. Select the data that you want to base your chart on. 

2. Select the Insert tab to display the Insert Ribbon. 

3. On the Insert Ribbon, click the relevant chart type button to show a menu of various ways to display your chart. 

 [image: image48.jpg]


 

Try it: Select the cell ranges A4:A10 and H4:I10 from Sheet 1 of Sales report.xlsx. Hold down the Ctrl key while using your mouse to select non-adjacent ranges of cells from a spreadsheet. Create a 3D clustered column chart from your selected data. 
Manipulating a Chart 
Once the chart has been created, there are a number of ways in which it can be manipulated. 

Moving and resizing a chart 
Sometimes it may be necessary to resize or even move your chart around in your spreadsheet. To do this, first single click in the chart area to display the chart area border. 
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If you place your mouse pointer on the corner of the chart border and let it hover, you will see your pointer turn into a double headed arrow. If you drag the chart corner with your mouse, you can resize the chart.  


[image: image50]
To move the chart, let your mouse pointer hover over any border. When you see your mouse pointer turn into a cross with four arrows, you will be able to move the chart around your screen by holding the left mouse button down and dragging. 
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Try it: Move the column chart underneath the spreadsheet data and make it larger. 
If you want to make a chart an object in another worksheet, or move the chart to a sheet of its own, do the following. 

1. Right-click on the chart 

2. Choose Move Chart from the drop down menu 

 Select New Sheet or a different sheet from the Object in: dropdown arrow Click OK 
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Try it: Move the chart to a new sheet; then move the chart back to Sheet 1. 
Note that you can also click the Move Chart button in the Design Ribbon to display the Move Chart dialogue box. 


[image: image53] 

To remove a chart from your worksheet: 

1. Click in the chart area 

2. Press the Backspace or Delete key on your keyboard. 

Adding a chart title 
To add a chart title: 

1. Click in the chart area to display the Chart Tools contextual tab 

2. Select the Layout tab 

3. Click the Chart Title button and select an option that will allow you to add a title 

4. Right-click on the Chart Title area that appears within the chart area  
Choose Edit Text and enter your chart title 

 
[image: image54] 

Adding chart axis titles 
To add chart axis titles: 

1. Click in the chart area to display the Chart Tools contextual tab 

2. Select the Layout tab 

3. Click the Axis Title button and select an option that will allow you to add an axis title 

4. Right-click on the Axis Title area that appears within the chart area  
Choose Edit Text and enter your axis title 

Try it: Add a chart title and axis titles to your chart. 
Changing the Type of Chart 
To change the chart type: 

1. Click in the chart area to display the Chart Tools contextual tab 

2. Select the Design tab 

3. Click the Change Chart Type button 

4. Select the new chart type and click OK or 
5. Right-click on the chart area and selecting Change Chart Type from the drop down menu that appears. 


[image: image55]
You can also display the Change Chart Type dialogue box by right-clicking the Plot area 

Try it: Change the chart into a bar chart, then back to a column chart. 
Formatting a Chart 
Even after you create a chart, you can still alter its appearance. You can change how a chart looks by: 

Selecting the chart area and selecting the Design tab or 

Selecting an object in the chart area then right-click and select Format [Object name] from the menu 

Advanced Chart Formatting Techniques
Adding new data to a chart quickly

You can add extra data to an existing chart quickly through copy and paste. You should try and make sure the data is the same size (the same amount of rows) to make the process smooth.
1. Highlight your new data to be added to the chart and copy it.

2. Click on the chart. Ensure the entire chart is selected and not a component of the chart.

3. Paste with CTRL V.

Using a secondary axis

Data types of different scales are difficult to show on the same chart. Using a secondary axis can help show two different scales of data on the same chart.

1. Select a data series that you wish to plot on a secondary axis.

2. Right-click and select Format Data Series.

3. Select Secondary Axis.

Combining chart types


[image: image56]
1. It can be effective to demonstrate two or more disparate series by combining multiple chart types onto a single chart.

2. Select a data series that you wish to change to a different type.

3. Select Change Chart Type and choose the type as required.

Creating template chart styles

If you find a set of formats and appearance to your chart that you’re happy with, you may wish to re-use this style. By saving a chart as a template you can apply the template repeatedly.
1. Design a chart so that it is as you like it.

2. Right-click the chart and choose Save As Template.

3. Choose a location and press Save.

4. To re-use your template, click Change Chart Type and browse the Templates section.

Unit 6 Practice Activity 
1. Open Exercise 6.0 - Charts.xlsx. 

2. Create a clustered column chart from the range A3:E9. Switch Row/Column to view the data grouped by Quarters.

3. Select the TOTAL series, format this data series as a line and assign it a Secondary Axis. Increase the Primary Axis to a maximum of 900 to give the Total line more space.

4. Highlight the range A3:A8 and F3:F8 to create a pie chart. Explode the Tennis Balls wedge.

5. Go to the Budget sheet. Create a donut chart from the data in A3:B12.

6. Create a radar chart from the data in A14:C19.

7. Go to the Satisfaction v Sale sheet. Create an XY Scatter chart from the data in A3:B103. 
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Online support forum and knowledge base www.microsofttraining.net/forum 
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Unit 7: Working With Sparklines 
 In this section you will learn how to: 
· Create a Sparkline in Excel 

· Modify Sparklines 

· Format Sparklines 

What are Sparklines? 
New in Microsoft Excel 2010, a sparkline is a tiny chart in a worksheet cell that provides a visual representation of data. Use sparklines to show trends in a series of values, such as seasonal increases or decreases, economic cycles, or to highlight maximum and minimum values. Position a sparkline near its data for greatest impact. 

Sparklines help bring meaning and context to numbers being reported and, unlike a chart, are meant to be embedded into what they are describing: 
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In the above example, the sales number alone gives you a single moment in time, but adding sparklines in the table, next to the numbers it’s describing, gives history and shows a pattern of sales. The sparklines aren’t floating on the grid of Excel like a chart does. They aren’t rows, column, or sheets away from the data. They are in the table giving context to the numbers, unobtrusively, and appear like text in the cell. 

Create a Sparkline 
Select an empty cell or group of empty cells in which you want to insert one or more sparklines. 

On the Insert tab, in the Sparklines group, click the type of sparkline that you want to create: Line, Column, or Win/Loss. 
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In the Data box, type the range of the cells that contain the data on which you want to base the sparklines. 

Note You can click [image: image59.jpg]


to temporarily collapse the dialog box, select the range of cells that you want on the worksheet, and then click [image: image60.jpg]


to restore the dialog box to its normal size. 

Modify a Sparkline 
When one or more sparklines are selected, the Sparkline Tools appear, displaying the Design tab. On the Design tab, you can choose one or more of several commands from among the following groups: Sparkline, Type, Show/Hide, Style, and Group. Use these commands to create a new sparkline, change its type, format it, show or hide data points on a line sparkline, or format the vertical axis in a sparkline group. 

Use the Style gallery on Design tab, which becomes available when you select a cell that contains a sparkline. 

Select a single sparkline or a sparkline group. 

To apply a predefined style, on the Design tab, in the Style group, click a style or click the arrow at the lower right corner of the box to see additional styles. 
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To apply specific formatting to a sparkline, use the Sparkline Color or the Marker Color commands. 

Customize sparklines 
After you create sparklines, you can control which value points are shown (such as the high, low, first, last, or any negative values), change the type of the sparkline (Line, Column, or Win/Loss), apply styles from a gallery or set individual formatting options, set options on the vertical axis, and control how empty or zero values are shown in the sparkline. 

Control Which Value Points Are Shown 
You can highlight individual data markers (values) in a line sparkline by making some or all of the markers visible. 
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In this sparkline, the high value marker is green, and the low value marker is orange. All other markers are shown in black. 

To show all values, select the Markers check box. 

To show negative values, select the Negative Points check box. 

To show the highest or the lowest values, select the High Point or Low Point check boxes. 

To show the first or the last values, select the First Point or Last Point check boxes. 

Show or hide data markers 
On a sparkline that has the Line style, you can show data markers so that you can highlight individual values. 

Select a sparkline. 

In the Show/Hide group, on the Design tab, select any of the check boxes to show individual markers (such as high, low, negative, first, or last), or select the Markers check box to show all markers. 

Clearing a check box hides the specified marker or markers. 

Show and customize axis settings 
You can select Date Axis Type (in the 'Group' group, click Axis) to format the shape of the chart in a sparkline to reflect any irregular time periods in the underlying data. 
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In a line sparkline, applying the Date Axis type can change the slope of a plotted line and the position of its data points in relation to each other. 

In a column sparkline, applying the Data Axis type can change the width of and increase or decrease the distance between the columns, as shown in the following image. 
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In the example shown here, there are two column sparklines that use data from the same range. The sparkline with the “Trend” label uses the General Axis type, and the sparkline with the “Trend (Data Axis Type)” label uses the Date Axis type. In each sparkline, the first two data points are separated by two months, and the second and third are separated by seven months. By applying the Date Axis type, the space between the three columns changes proportionally to reflect the irregular time periods. 

You can also use these Axis options to set minimum and maximum values for the vertical axis of a sparkline or sparkline group. Setting these values explicitly helps you control the scale so that the relationship between values is shown in a more meaningful way. 

With the sparkline or sparkline group selected, in the 'Group' group, click Axis. 

Under Vertical Axis Minimum Value Options or Vertical Axis Minimum Value Options, click Custom Value. 

Set minimum or maximum values that you feel will best emphasize the values in the sparklines. 

You can increase the height of the row that contains the sparkline to more dramatically emphasize the difference in data values if some is very small and some is very large. 

You can also use the Plot Data Right-to-Left option to change the direction in which data is plotted in a sparkline or sparkline group. 
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If there are negative values in your data, you can emphasize this by showing a horizontal axis in your sparkline. 

With the sparkline or sparkline group selected, in the 'Group' group, click Axis. 

Under Horizontal Axis Options, click Show Axis. 

Any sparklines that contain negative data will display a horizontal axis at 0. 

[image: image66.jpg]


 
Handle Empty Cells Or Zero Values 
You can control how a sparkline handles empty cells in a range (and thus how the sparkline is displayed) by using the Hidden and Empty Cell Settings dialog box. 


[image: image67]
Unit 7 Practice Activity 
1. Open Exercise 7.0 - Sparklines.xlsx. 

2. Select the Dec 2010 Sales Data worksheet. 

3. Click on cell E8. 

4. Select the Insert ribbon and click the Column button in the Sparklines group. 

5. Click on the [image: image68.jpg]


 button and select the range B4:M4 in the Annual Sales Data worksheet. 

6. Click on the [image: image69.jpg]


 button and then click OK. 

7. Using the fill handle in the bottom right corner of cell E8 copy the Sparkline down to cell E18. 

8. From the Sparkline Tools contextual tab Design ribbon in the Show group, add a High and Low point and a First and Last point. 

9. Select a Style from the Style group.  

10. With all Sparkline cells selected modify the type to a Line. 
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Unit 8: Design and Layout
The hard work put into dashboards as a BI tool can easily be ignored if they are not laid out sensibly and with sympathetic design.

Gridlines and outlines

Most spreadsheets that are designed for viewing as a report benefit from reducing clutter. One of the easiest way to reduce clutter on a spreadsheet is remove excess lines from view.

Removing gridlines

Remove Excel’s default gridlines to make the screen less busy.
1. Select the View menu.

2. Uncheck Gridlines.

Removing outlines

Many objects, such as charts, have a thin outer border. Removing them allows them to sit naturally on the background.

1. Select the object.

2. Select the Format menu.

3. Select Shape Outline.

4. Choose No Outline.

Design and images

A little thought and care when choosing a colour scheme for the dashboard can greatly aid readability.
Backgrounds

A custom background image, such as a world map or client logo, can help provide context to the dashboard.

1. Select the Page Layout menu.

2. Select Background.

3. Browse for the image you want to use.

Design Themes

Using Excel’s built in themes consistently across your dashboard will help the individual elements look like part of the same project.

1. Select the Page Layout menu.

2. Select Themes.

3. Choose the theme you wish to use.

4. Modify it from the Colors, Fonts and Effects drop-downs.

Colours

Picking the right colour scheme can greatly aid the acceptance of your dashboard. You should aim for complementary colours, or colours all from the same range. Dashboards that are all shades of red, shades of green or even a greyscale dashboard can have a striking impact.

Aligning objects

To give your Excel dashboard a professional feel, ensure all objects are lined up with each other.

1. Select the objects (e.g. charts, PivotTables, images) you want to line up (use the CTRL key to select multiple items).

2. Select the Page Layout menu.

3. Choose Align.

4. Choose from one of the align options as required.

As well as using this method, you can also hold the ALT key while you are moving Excel objects to snap them to cells.

Other design tips

· Sketch out your dashboard before designing. This will ensure you are making the best use of space

· Use very thin / narrow rows and columns as spacers between objects and tables

· Use a minimal colour scheme. Perhaps one theme colour (e.g. blue) and use shades of that throughout your design. You can then use an opposing colour (e.g. orange) as an accent to show off key features

· When using charts, remove as much ‘junk’ as possible so the message is still clear with as few distractions as possible

· Remove gridlines before use

· Have as few input cells as possible on your dashboard

Using the Camera Tool

A big problem with trying to get different Excel tables lined up is the width and height and rows and columns. You may have the data you want, but then trying to align them on the same worksheet can be problematic.
One of the best methods to circumvent this issue is with the obscure Camera Tool in Excel. In the diagram below there’s a PivotTable on the left and a Picture of it on the right.
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The Camera Tool is a hidden feature in Excel that allows you to insert a picture that is linked to its source data. If any of the data changes, or if the formatting is changed, this is reflected in the picture. By turning a table into a picture it floats over the spreadsheet and can be positioned anywhere.

You can also treat the resulting picture like any other Excel picture: you can add borders, shading, resize it freely, reflections, rotation, 3D styling and much more.

Adding the Camera Tool

You can add the Camera Tool to the Quick Access Toolbar.

1. Go to File – Options – Quick Access Toolbar.
2. Under Choose commands from, choose All commands.

3. Scroll through the list and find Camera, then press Add then OK.

The Camera Tool will now be available from the Quick Access Toolbar.
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Taking a picture with the Camera Tool

1. Highlight the data you wish to take a picture of.

2. Click the Camera Tool.

3. On your spreadsheet, draw a rectangle to create the picture.
Any changes to your source data will automatically update on the picture. You can also change the formatting, row heights and column widths and they will all be reflected on the picture.

Note: if you copy and paste the picture on to another worksheet, your picture will instead reflect the same range on the destination sheet. For this reason you should select your target data, click the Camera Tool then change sheets before creating your picture.

Advantages of the Camera Tool pictures

· You can move the pictures and resize them anywhere you like. You are not governed by row or column boundaries.
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· You can apply any picture effects to the data (this isn’t always practical but your options are vast!)
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· You can combine tables and charts much more cohesively and with greater freedom by placing a picture of your data near on on top of your chart.
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Appendix I: Sample Dashboard Projects
Project 1: Worldwide salary index
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File: Project 1 - Salary Dashboard.xlsx
Key tools: 3 PivotTables, 2 PivotCharts and 1 Slicer
 SHAPE  \* MERGEFORMAT 




Project 2: Sales analysis
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File: Project 2 - Sales Analysis.xlsx
Key tools: IF, SUMIFS, EDATE, Conditional Formatting, PivotChart,Sparklines, Data Validation

 SHAPE  \* MERGEFORMAT 




Project 3: Helpdesk efficiency
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File: Project 3 - Helpdesk Efficiency.xlsx
Key tools: Conditional Formatting, Charts, Form Controls (scroll bar and combo box)


[image: image79]
Appendix II: External Data Sources

Importing Data from the Web

Creating web queries
Web pages often contain information that is perfect for analysis in Excel. Using a web query you can you can retrieve data and that is either static or refreshable. That is, the data in Excel will update with the latest data on the Web page. 
To import data from the web, start with a blank worksheet:

1. Select Data, Get External Data. 
2. Choose From Web.

3. In the New Web Query dialog type the website address (URL).
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For example choose a table from the BBC website.

Click the yellow arrow next to the table you wish to import.

A green tick box confirms which table of data you are choosing to import.

Formatting data
Before importing you may wish to choose how to format the data.

Select Rich text formatting if you wish to preserve the formatting or the website. 

Select Full HTML formatting if you want to include hyperlinks within the selected table.
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Applying conditional formatting to imported data 
When imported data is likely to change quite often is would be useful to make it automatically refreshable and display the latest data values. For example when using currency exchange rates you could refresh to see the current rate or show the change in the exchange since it was imported.

In the following example the data is imported from a website (such as www.xe.com) that displays currency exchange rates from UK Pounds to a selection of other currencies.

Several of the rows of imported data are hidden so that only rates against GBP are visible.

It is possible with Excel’s conditional formatting to indicate whether a rate goes up or down since it was first imported. This is done by copying the data as values to a separate part of the sheet (row 170 in the example below).

A conditional formatting rule can then be used to turn an increase in value to green or a decrease to red. 
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Icon sets can also be set up to achieve the same result. First create a formula that calculates the % increase or decrease. 

=(C69-C170)/C170
Copy the formula across to apply to all the exchange rates. Then create a rule on the range of cells containing the changing exchange rates.
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With this rule an increase is represented by a green up arrow, a decrease by a red down arrow while a yellow arrow indicates no change.  

Enabling automatic refreshing

Finally you can set the refresh rate to update every few minute. To set automatic refresh 

1. Right click on one of the imported cells of data.

2. Select Data Range Properties.

3. Tick Refresh Every and enter the time interval between automatic refreshes.

[image: image159.png]21X

Corsandtines | sze | Protecton | Proprts | web (Gl

value
 Unchecked
& chedked
€ mixed

cnk [ =

T~ 3D shading

Concel





Importing Data From Text Files

Excel can import data saved in a text file format directly into a worksheet. The text file format is commonly used when data is exported from other database applications.

The characters that separate fields are known as delimiters. Common delimiters include tabs, commas, or spaces. When working with text-formatted data, Excel can import files containing the following formats:

· Text (tab delimited - .txt)

· CSV (comma delimited - .csv)

· Formatted Text (space delimited - .prn).

You use the Text Import Wizard to convert the text data.

1. Click the Data tab.

2. In the Connections group, click the Get External Data button.

3. Click on From Text.

4. In the Import Text File dialog box, locate and select the file you want to import.

5. Click the Import button.

6. In the first page of the Text Import Wizard, select the options you want.

7. Click the Next button.

8. In the second page of the Wizard, select the delimiter.

9. Click the Next button.

10. In the third page of the Wizard, select each column in turn in order to specify the data format in that column.

11. Click the Finish button.

12. In the Import Data dialog box, indicate the location for the data.

13. Click the OK button.
Importing Data from Access
You may want to work with Access data in an Excel workbook in order to take advantage of Excel’s data analysis and charting features, the flexibility in data arrangement and layout, or the many functions that are not available in Access.
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1. On the Data tab, in the Get External Data group, click From Access.

2. Double-click the Access database that you want to import.

3. In the Select Table dialog box, click the table or query that you want to import, and then click OK. 

4. In the Import Data dialog box, do the following:

5. Optionally, click Properties to set refresh, formatting, and layout options for the imported data, and then click OK.

6. Under Where do you want to put the data? do one of the following: 

a. To return the data to the location that you selected, click Existing worksheet.

b. To return the data to the upper-left corner of the new worksheet, click New worksheet.

7. Click OK.

Importing Data from Other Sources

You can use Microsoft Query to import information from many database applications. The Query Wizard, part of Microsoft Query, guides you through the steps to create a query.
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1. To create a database query, first select the Data tab.

2. Click the From Other Sources command.

3. Click on From Microsoft Query.

4. Click the name of the data source you want to use.

5. Ensure there is a tick against Use the Query Wizard to create/edit queries.

6. Click the OK button.

7. In the Select Database dialog box, locate and select the database containing the data you want.

8. Click the OK button.

9. In the Query Wizard select the columns to use by clicking the + in the Available tables and columns window.

10. Select the fields to be used, in turn, and click the > button to include them in the query.

11. Click the Next button.

12. In the next page of the Query Wizard, set any criteria for filtering.

13. Click the Next button.

14. Set up any sort order you want.

15. Click the Next button.

16. Click the Save Query… button.

17. Type a name and click the Save button.

18. To return the data to Excel, click the Finish button.

19. In the Import Data dialog box, select the options you want.

20. Click the OK button.
Using other data sources with a PivotTable

Consolidating multiple sheets or ranges of data into a PivotTable
Most of the time you will create a PivotTable from a data list or Excel table, but you can also summarise multiple data ranges using a PivotTable if the data is formatted appropriately. 

To consolidate a series of data ranges into a PivotTable the ranges must be laid out in cross-tabular format and have exactly the same structures. For example:
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Note the “Region-Year” Field. Normally in a cross-tabular table you would split these headings into separate cells and rows. To consolidate multiple ranges, the region containing the data and all the labels must be perfectly rectangular,therefore there must be data in each one of the cells and no blanks. The data on the other worksheets has the exact same layout.  

If you want to create a PivotTable using this data you need to do something a little different to how you would usually create a PivotTable from a data list or Excel. You need to run the PivotTable Wizard which can be accessed by holding down:

Alt + D + P

The wizard will launch. On the first page, select the multiple consolidation ranges option and click next:
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Then select the “I will create the page fields” option and click next:
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On the next page you can select the worksheet ranges you want to consolidate:
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In the range field, click the collapse dialogue box button, then select the cells that contain the data on the first worksheet. Expand the dialogue box, then click Add. Repeat for each range. 

We don’t want page fields/report filter fields so leave that set to 0 and click next.  On the final page of the wizard,select the new worksheet option and click finish. The data will immediately be pivoted:

[image: image91.png]K d9- ¢ o BIs T Consolidating.xisk = Microsoft Becel ]

sotTable Tools

[— O

i e i T i c@-sx
PivotTable Name:  Active Field: A= ’;h ™ B Clear
: &
Pottablez | [sum of value & Ungroup il C g seear B OLAPTools
41 o | et Resh CrangeData | Cataatons

(& Options ~ | @ Field Settings 3 nextt, | Refresh Chanoe D212 | 63 Move PotTable | = | BB What.if Anaysis

it e | sonuriter o ions oo S

w B

& T o T lo ¢ G S O ] 0 T
1]
2

oot vaimecotumn Labets [ <]
© Rowises 2007 a8 2009 2010 Grea Tt
5 e ssert e seeer arrss 2102
& vomn Sar e e eose o
7 somn Geore s oo sesss
& west Sonix s cwosr siser  aireos
5 GronaTorat Joss01 213098 228295 206620 356508
10 B
11
12
1]
i
= Dro ks between areasbelow:
i 7 Report Fiter 3 Column Labels.
ol EENa—a
2 i Rowlabes X Vahes
0| S [Row v ] [sumofvake  ~
| = rre—
4 4> M| Sheetl ~ SupportCals OrderCalls .~ RetunCalls . #J





Notice in the PivotTable field list that the fields have the names “Row”, “Column” and “Value”. To change these titles, click any cell in the PivotTable with a value for the field I want, for example “North” which is part of the “Row” group. To change the name of the active field, click on the Options table and into the Active Field box and change it appropriately; for example, to “Region”:
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The name of the field will change over in the PivotTable field list. Consolidating multiple data ranges occurs relatively infrequently but can be useful when dealing with legacy workbooks which have data laid out in cross-tabular format.  

Using external data sources (Excel)
Excel enables you to build PivotTables from data found both inside and outside the workbook where you create the PivotTable. If you want to create a PivotTable from a data source that your either can’t or don’t want to import into Excel directly, you can create a connection to that data source and work with it in place.

If you want to create a PivotTable using data from another Excel workbook, go to the Insert Tab and click the PivotTable button. In the Create PivotTable dialogue box, click the Use External Data Source option and click “Choose Connection”. 
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In the Existing Connections dialogue box, if the connection or the data source youw ant already appears then simply click it and click Open. Otherwise, click the Browse For Button:
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This will display a version of the Open dialogue box, Select Data Source. Browse for the data you want and then click open.
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The select table dialogue box will appear, showing the different data sources available in the target data source to create the PivotTable:
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Note that the first row of the data is assumed to have headers. Click OK and Excel will seend you back to the Create PivotTable dialogue box. Now create a PivotTable as normal: 
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You can Pivot this, filter, add styles as usual. One important thing to note is that if you usean Excel workbook as your data source, you cannot open it while the workbook with the PivotTable is open. You will get an error message indicating that the file is in use and cannot be opened. Once you close the PivotTable workbook, the external file can be opened as normal. 

If possible, you should always draw the data for the PivotTable from the original source so that any changes in that source are reflected in the PivotTable. 

Using external data sources (Access)
Some small businesses maintain important business data in an Access database. You can create a PivotTable based on the original database table instead of importing the data into Excel.

To create the PivotTable, click the Insert Tab on the ribbon and then the PivotTable button. In the Create PivotTable dialogue box, select the Use External Data Source option and then click Choose Connection:
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The connection we want doesn’t exist in the existing conenction list so click Browse For More:
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Then navigate to the Access database in question, select and click OK. You will be returned to the Create PivotTable dialogue box and you should create the PivotTable as normal. The result will be this:
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You now create a PivotTable as normal:
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Creating a PivotTable by connecting to an Access database table saves you the trouble of importing the data into your workbook. However, you must be able to connect to the database wither as file on the same computer or on the network, for the PivotTable to have the most current data. If this might potentially be an issue, then you should import the data into Excel and create your PivotTable from that imported data.

These techniques also allow you to connect to an Online Analytical Processing – or OLAP – cube such as those produced by SQL Server. 
Appendix III: Advanced Charts
In this section you will learn how to: 
· Create a Speedometer chart 

· Create a Tornado chart

· Create a Waterfall or Step chart

· Format mini-charts

The standard charts in Excel will fulfill most of what you need. However there are some specific chart types which are popular, particular in dashboard reporting.

Speedometer Chart
A Speedometer or gauge chart can be a way of showing progress, and how close something is to hitting a target.
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It is created out of two series of data: one is the ‘traffic light’ part, the second is the indicator. The first series is formatted as a Doughnut chart, the second as a pie. There are three segments of data which are formatted to have no colour so they do not show up on the final chart.

For this to work you will need to lay out your data similar to this:

	
	A
	B

	1
	Donut Values
	Pie Values

	2
	33
	62

	3
	33
	1

	4
	33
	=200-B2-B3

	5
	100
	


Creating a Speedometer chart

1. Select your data.

2. On the Insert tab, in the Charts group, choose Other Charts, and select Doughnut.

[image: image104.png]BHS @

Bl B
Rl ¢
Sicer Timeline Hyperink  Text Header
Box & Footer
Fiters ks Text
K M

4-

? @ - x
pro—1
T Equation -
Q symbol
symbais N
v
N o

9 ] O e k- A
5 B A @Y e @ : i
PivotTables Pictures @+~ .‘MyApm H Charts - View Loss.
PR D @v @F
O @o @8
A B C D E F H 1
1
2 @
3 2 Values
-
4 62
G
s e B
N
6 137
7 ® More Pie Charts.
8
9
10
11
12
13
14
15
16
17
18

‘Speedometer (unformatted) | Speedometer with title and spin |





3. Select each data point and click Format Selection to change the fill (Solid fill or No fill). For the Pie series (3 data points), change the fills to No fill, black (small part) and No fill respectively. You may find it easier to use the ← and → keys to select a data point.
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4. Select the Doughnut series, click Format Selection, and change the angle to 270 degrees.

5. Select the chart, right click, click Format Chart Area and change to No fill and No line.

6. Remove the legend.

7. Select the Pie series and change the chart type to Pie.

8. Select the Pie series, click Format selection, and change the angle to 270 degrees and plot the series on the secondary axis.
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See the accompanying file on how to add a Spinner to this chart.
Tornado Chart
Tornado diagrams are a classic tool of sensitivity analysis to provide decision makers a quick overview of the risks involved. They can also be used to demonstrate a funnel breakdown. A tornado chart to show a financial analysis for a project may look like this:
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Create a Sensitivity Tornado Diagram
1. Select the data.
2. On the Insert ribbon, choose Bar. Pick Clustered Bar (first one in the 2-D section).
3. Right-click on the horizontal axis, choose Format Axis. On the bottom of the Axis Options pane look for Vertical Axis crosses: choose the Axis value radio button, and type your base case value (the average of your base values).
4. Without closing the window, choose the vertical axis of the chart. Again on Axis Options, check the box Categories in reverse order, and set the Axis Labels menu to Low.
5. Without closing the window, click on any of the bars, which should bring the Series Options pane. Move the slider Series Overlap completely to the right (Overlapped).
A tornado chart can also be used to show variation between regions, years or products. This is sometimes known as a funnel diagram, as below:
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Create a Sales Funnel Tornado Diagram
1. First, make one of your series negative. A quick way to do this is to type “-1” into a cell, copy it, select your target data, go to Paste – Paste Special and click Multiply.

2. Sort the data descending.

3. Select the data.
4. On the Insert ribbon, choose Bar. Pick Clustered Bar (first one in the 2-D section).
5. Right-click on any of the bars, which should bring the Series Options pane. Move the slider Series Overlap completely to the right (Overlapped).
Waterfall Chart
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Waterfall charts, sometimes known as bridge or step charts, are popular ways of showing how values are distributed, or how amounts are broken down from period to period.
They are often used in budgets, showing how the amounts grew or shrank from one year to the next. It could also be used to show how sales or profits progressed across a financial year.
To create this chart in Excel you need to create a stacked column chart with a series that ‘props up’ the real value. This series is then formatted with no fill or outline colour and becomes invisible on the chart.
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Creating a waterfall chart

Start from a series of positive and negative values. You will then need to create several ‘helper’ columns to build the chart. In the formulas below the grid is as per the screenshot.
1. Create 5 more columns to the left of your values:
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a. Base
Sum of the previous value, plus the starting amount, plus up values, less any down values:

=SUM(B3,E3:F3)-D4

b. End
The total displacement of the amounts:
=SUM(B15,E15:F15)-D16
c. Down
The lowest of out of column G or zero:
=-MIN(G4,0)
d. Up
The highest of out of column G or zero:
=MAX(G4,0)
e. Start
The same as your starting value:

=G3
2. Select your data. If as above it is A1:F16

3. Go to Insert – Column Chart – Stacked Column Chart.

4. Select your ‘Down’ series and format red.

5. Select your ‘Up’ series and format green.

6. Format your ‘Start’ and ‘End’ bars as required.

This can be quite a lot of steps to get your head around; look at the accompanying worksheet to help you out.
Formatting mini-charts

Sparklines are perfect for showing quick correlations. But sometimes you will want more granularity in your options and a series of mini-charts will be a better idea.
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Mini-charts are regular Excel charts, but formatted appropriately for a small size.

Formatting mini-charts

How you format charts is personal choice, however there are some general considerations to bear in mind:

· You should be able to see the patterns at a glance. They are for recognizing trends so you can ignore the expected and concentrate on the surprises.

· Lines or bars should be bold, complementary colours. You should increase the line thickness as appropriate too.

· Keep the colour scheme consistent across the various mini-charts too.

· Keep the tick marks widely spaced. You want to see trends, not detail. Right-click the axis and choose Format Axis and change the Major and Minor Units to find a good spacing.
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· Format the axis Display Units to show Thousands or Millions as appropriate and save space. Right-click an axis, Format Axis, under Axis Options choose the Display Units drop-down.

· Mini-charts are one of the few chart types that look better with both horizontal and vertical guidelines.

· Remove all unnecessary clutter – is the Legend needed? Data Labels?

· Change the font to a narrow style font face to save space – Arial Narrow is a good choice.

· Decrease the font size as much as you can.

· Resize the Plot Area inside the chart to maximize the space inside the Chart Area.
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· Once you have settled on a style, save as a template for easy recycling (see Unit 6 for details). You should save a template for each mini chart type you require (e.g. area, line, stacked column).

· To see how effective your charts are, zoom out on your sheet to around 50% and the chart will still be mostly readable.

Alternatives to mini-charts could include Sparklines or Conditional Formatting Data Bars.

Appendix IV: Dealing with Dynamic Data Sources

In this section you will learn how to: 
· Use an dynamic range name

· Understand Table formatting

Format as Table
What is a Table?

In Excel, a table is a specially designated range of numbers. This special range of numbers has added functionality that other cell ranges do not have. You can have more than one table in a workbook or worksheet if you want, and tables can be as large or small as the amount of data you want to work with.
Normally a table is made from adjacent columns of data, with a unique label or heading for each column. Each row in the table should have entries organised according to the column headings. You should keep your table data adjacent in a block to take advantage of all of Excel’s table features. Some Excel features, like filters and PivotTables, will not work correctly if the data is not blocked together in adjacent columns as a table.
One of the key advantages with working with a Table is that the table range will automatically increase as more rows are added. If you have used an Excel Table as the basis for a PivotTable, when the PivotTable is refreshed it will grow to accommodate these new rows. These new rows can either be typed manually or pasted on to the bottom of the table.
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Creating Tables

To create a table from an existing range:

· Pre-select a range of data in adjacent columns or click any cell within the required data range

· On the Home Ribbon, Style group, click on the Format as Table button.
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· This will display a menu of table formatting options. If you click on one of the table menu options, the selected range will be formatted as a table based on the style of your choice.
· When you choose a table format, you will see a Format as Table dialogue box appear.
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· If there are column headings in the first row of the range you selected for your table, check the box that says, “My table has headers.”
· Make sure the cell range shown is the range that you want for your table; 

· Click the OK button to create your table.
Changing the Table Range
To change the table range – method 1:

· Use the small blue move handle in the bottom right corner of the table. 
· Position your mouse on top of the move handle, then hold down your left mouse button and drag the move handle to resize the table. 
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To change the table range – method 2:
· Click on a cell in your table

· The contextual Design tab appears above the ribbon area of the screen. This contains options for working with your table.
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· In the Properties group, click Resize Table button. 

· The Resize Table dialogue will appear on your screen. 
· Select the new table range with your mouse.
· Click OK and your table will be resized.
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Inserting Table Columns

To add a column to the table:

· Right click on a cell in the column next to where you want to insert a new column.

· From the menu, choose Insert, and then Table columns to the Left, or Table columns to the Right.

You can also quickly add additional columns to your table by clicking a cell to the immediate right of the table and then entering data into the cell.

Inserting Table Rows

To add rows to the table:

· Right click on a cell in the row below where you want to insert.

· Choose Insert from the menu, and then choose Table Rows Above from the submenu.

You can quickly add a new row to the end of a table by clicking on a cell immediately below the table and entering data into it. The new row will automatically be included in the table range when you press the Enter key after typing your data into the cell.

Deleting Rows or Columns
To delete a row from your table:

· Right click on a cell in the row that you want to remove
· Select Delete, and then choose the Table Rows option. 
To delete a column from a table:

· Right click on a cell in the column that you want to remove

· Select Delete, followed by Table Columns, from the menus.
Creating a Table Total Row

If you are working with a table in Excel 2007 and you click on a table cell, a contextual Table Tools tab should appear containing a Design ribbon.

· Select the Design Ribbon

· In the Table Style Options group, check the box labeled Total Row. 
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· This will display another row at the bottom of the table, with the word Total in the first cell. 
· Select a cell in the Totals Row and a drop-down arrow will appear.
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· Choose a function type from the drop-down list to apply to the particular column of data.

If you drag the move handle to lengthen the table, the Total Row will stay at the bottom.

If you enter any new data into the table the values in the Total Row cells will be recalculated accordingly.

If you want to change what is displayed in the Total Row, you can click on any cell in the row and choose another option from the drop-down list.

You can hide the Total Row by:

· Clearing the Total Row checkbox on the Design Ribbon, Table Style Options group; or

· Right click a cell in the table and select Tables then Totals Row.
Dynamic Range Names

You may be unable to convert your data into a Table, or it may be impractical to do so. In this case you should use a dynamic range name. Instead of creating a range name in the usual way, you should use the OFFSET function to dynamically build a range name for you.

In this context, OFFSET looks like this:
=OFFSET(from, this many rows, this many columns, [return this many rows], [this many columns])
To create a dynamic range name:

1. Go to Formulas – Define Name.

2. Enter a name for your range name.

3. In the Refers To box, enter a formula in the following format:
=OFFSET(Pivot!$A$1, 0, 0, COUNTA(Pivot!$A:$A),4)
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Assuming your worksheet is called Pivot, and your data begins in A1.
Note: for a dynamic number of columns, replace the 4 with: COUNTA(Data!$1:$1)
4. Press OK.

Note the use of the COUNTA function to determine the amount of rows and column in the dataset. If there are other items of data on the sheet this will affect the count, and therefore distort the range.

Using a Dynamic Range Name in your PivotTable

1. Go to Insert – PivotTable

2. In the Table / Range box type the range name (or press F3 to bring up the Paste Names dialogue box).

3. Choose New / Existing Worksheet as required and press OK.

Now when you Refresh your PivotTable it will recalculate to include new data in your table.
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